Producing Presentations
A Beginner's Guide to PowerPoint

January 13, 2005
Table of Contents

TABLE OF CONTENTS .................................................................................................................. III

INTRODUCTION ............................................................................................................................ V
  ABOUT THIS COURSE .............................................................................................................. V
  READING THIS MANUAL ......................................................................................................... V
  WHAT IS POWERPOINT? ......................................................................................................... V

CHAPTER 1 GETTING STARTED ................................................................................................. 1
  STARTING POWERPOINT ...................................................................................................... 1
  THE POWERPOINT SCREEN ............................................................................................... 2
  THE MENU BAR .................................................................................................................... 3
  USING THE TOOLBARS ....................................................................................................... 6

CHAPTER 2 CREATING A PRESENTATION ............................................................................... 7
  CREATING A NEW PRESENTATION .................................................................................. 7
  APPLYING A TEMPLATE TO A PRESENTATION ......................................................... 8
  CREATING A TITLE SLIDE .............................................................................................. 9
  SAVING PRESENTATIONS ............................................................................................... 9

CHAPTER 3 TEXT .................................................................................................................... 11
  INSERTING A BULLETED LIST SLIDE .......................................................................... 11
  INSERTING TEXT ........................................................................................................... 12
  BULLETED LISTS ......................................................................................................... 12
  FORMATTING TEXT .................................................................................................... 17

CHAPTER 4 GRAPHICS ....................................................................................................... 20
  INSERTING A PICTURE SLIDE ..................................................................................... 20
  THE PICTURE TOOLBAR .............................................................................................. 21
  INSERTING AN AUTO SHAPE ...................................................................................... 23
  THE DRAWING TOOLBAR ............................................................................................ 24

CHAPTER 5 TABLES ............................................................................................................. 27
  INSERTING A TABLE SLIDE ......................................................................................... 27
  CREATING A TABLE .................................................................................................. 27
  FORMATTING TABLES ............................................................................................ 28

CHAPTER 6 WORDART ......................................................................................................... 33
  INSERTING WORDART ................................................................................................. 33
  FORMATTING WORDART ......................................................................................... 34

CHAPTER 7 ANIMATION .................................................................................................... 37
  THE ANIMATION TOOLBAR ....................................................................................... 37
  ANIMATING YOUR PRESENTATIONS ........................................................................ 37
  CUSTOMIZING ANIMATION .................................................................................... 38

CHAPTER 8 FORMATTING SLIDES ..................................................................................... 41
  CHANGING SLIDE BACKGROUNDS ........................................................................ 41
  SLIDE FOOTERS ....................................................................................................... 42
  APPLYING A TEMPLATE .......................................................................................... 42
  EDITING A TEMPLATE MASTER ............................................................................... 43

CHAPTER 9 OTHER POWERPOINT FEATURES ................................................................ 45
  GRAPHS ....................................................................................................................... 45
  DIAGRAMS & ORGANIZATION CHARTS .................................................................... 46
Introduction

Welcome to Producing Presentations: A Beginners Guide to PowerPoint!

About This Course

Producing Presentations is an introduction to the Microsoft PowerPoint program. After completing this course, you will be able to produce professional-looking slide presentations for your classes.

Reading This Manual

There is more material in the manual than we will be able to cover in the class time. During the class, we will restrict our activities to those marked with a 📚. We will leave the other activities and topics for you to try at home, or in a computer lab on campus.

This manual is yours to keep. Since our time is so limited, please only do the steps marked with a mouse icon. You will be able to try the other sections or just experiment on your own at any time after this course.

What is PowerPoint?

PowerPoint is a computer slide show package that allows you to create professional-looking presentations quickly and easily. You can create entire presentations from scratch with the tools PowerPoint provides, or you can import text and graphics from other programs. This way, you can “pull together” a presentation from information you already have on your computer.

You can use PowerPoint to create a series of slides containing both text and graphics. You can then choose to print your slide show on overheads, or present it directly from your PC. In addition, you can print your presentation for your audience, giving them a paper with room to write notes.

PowerPoint provides you with templates, colour schemes, drawing objects and clip art pictures to enhance your presentation.
Chapter 1 Getting Started

In this chapter, you will learn:

- how to start PowerPoint
- the basics of the PowerPoint screen
- how to use the menu bar
- how to use the toolbars

Starting PowerPoint

PowerPoint can be started many different ways, depending on your computer. To start PowerPoint in the IT computer labs, follow the steps below:

Starting PowerPoint:

1. Click **Start** in the task bar.

2. Select **Programs**.

3. Select **Microsoft PowerPoint**
Producing Presentations

Getting Started

The PowerPoint Screen

You should now see a blank title slide on your screen, as well as several toolbars. You may also see the animated office assistant.

<table>
<thead>
<tr>
<th>Screen Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Window</td>
<td>Contains the PowerPoint application</td>
</tr>
<tr>
<td>Document Window</td>
<td>Contains your presentation</td>
</tr>
<tr>
<td>Title Bar</td>
<td>Shows the name of the program (PowerPoint) and the name of the open presentation.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>Provides access to all PowerPoint</td>
</tr>
</tbody>
</table>
Producing Presentations

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Toolbar</strong></td>
<td>Provides quick access to the most common menu commands</td>
</tr>
<tr>
<td><strong>Formatting Toolbar</strong></td>
<td>Provides quick access to the most common formatting commands</td>
</tr>
<tr>
<td><strong>Task Pane</strong></td>
<td>Provides quick access to many formatting changes.</td>
</tr>
<tr>
<td><strong>Outline View</strong></td>
<td>Shows an outline of all of the text in the presentation. Can be used to edit and rearrange text.</td>
</tr>
<tr>
<td><strong>Slide View</strong></td>
<td>Shows text and graphic layout for each slide.</td>
</tr>
<tr>
<td><strong>Notes View</strong></td>
<td>Place to store personal speakers notes for the presentation that you don’t intend to show on the screen, but rather use from a printout.</td>
</tr>
<tr>
<td><strong>Text boxes</strong></td>
<td>Placeholders for text. Location and formatting is decided by the Slide Layout chosen.</td>
</tr>
<tr>
<td><strong>Drawing Toolbar</strong></td>
<td>Provides quick access to the most common drawing commands.</td>
</tr>
<tr>
<td><strong>View Buttons</strong></td>
<td>Allows you to quickly change how you view your presentation: Normal, Outline, Slide, Slide Sorter, and Show.</td>
</tr>
</tbody>
</table>

The Menu Bar

Every command that PowerPoint can process is available through the menu bar. When you click on a category heading, such as *File*, you will see a drop-down menu of all the commands available in that category.

Using the Menu Bar:

1. **Click File** on the menu bar. Take a look at the drop-down menu of choices available:
2. **Move** the mouse pointer across the menu bar to the other categories: *Edit, View, Insert, Format, Tools, Slide Show, Window,* and *Help.*

3. **Move** your pointer back to the *Edit* menu.

4. **Click** any command you want, just to see what happens. Some commands require different follow-up actions, and not all commands are activated.

5. If a new window pops up when you click a command, just **click** the `x` in the top right hand corner to close it.

6. **Press** either the *Esc* key or the *Alt* key to return to your slide show, or **click** anywhere inside the main window.

If you tried a few commands from the Edit menu, you probably noticed that they did not all act the same way when you clicked them. Here are some important facts to remember about the menu bar:

<table>
<thead>
<tr>
<th>If the command is:</th>
<th>It means:</th>
</tr>
</thead>
<tbody>
<tr>
<td>followed by a keyboard combination</td>
<td>you can use the keyboard shortcut rather than the mouse to run this command.</td>
</tr>
<tr>
<td>followed by a ‣</td>
<td>another menu with additional choices will appear.</td>
</tr>
<tr>
<td>dimmed or gray</td>
<td>you cannot use this command at this time. Try modifying the selection, or the location of your cursor.</td>
</tr>
</tbody>
</table>
Producing Presentations

followed by an ellipsis (…)
a dialogue box will appear, and you must enter more information.

preceded by a small icon
there is a similar button on the toolbar that runs the same command.

preceded by a small icon that appears pressed in
the command is currently running.

Menu showing only recently used items:

1. **Click Edit** on the menu bar. Take a look at the drop-down menu of choices available:

   ![Menu with Edit options](image)

   1. **Click Edit** on the menu bar. Take a look at the drop-down menu of choices available:

   ![Menu with Edit options](image)

2. After pausing on the menu for about 5 seconds, you may notice the menu expand as follows:

   ![Menu with expanded choices](image)

3. This feature will show you the most commonly used commands first, and then will expand to show all commands.
4. To turn the feature on or off, go to View, then choose Toolbars, then choose Customize.

5. Click on the Options tab.

6. Check off or remove the checkmarks as appropriate:

   - Menus show recently used commands first
   - Show full menus after a short delay

Using the Toolbars

The buttons on PowerPoint’s toolbars provide quick access to common commands. If you want to know what a button does, move your mouse pointer over the button, but do not click. A tool tip will appear, describing its function. To start a command, click the button.

The ‘Standard’ and the ‘Formatting’ toolbars share the top row of the PowerPoint screen, and appear as follows:

There are many extra buttons that do not show by default, but they can be accessed with the More Buttons icon that is in the middle and at the end of the toolbar.

For example, if you would like to use the Increase Font Size button, you may notice that you can’t see it on the toolbar. But, if you click the More Buttons icon at the far right hand side of the toolbar, you can click the Increase Font Size button. After choosing the Increase Font Size button, it will now be visible on the main toolbar row.

To turn the feature on or off, go to View, then choose Toolbars, then choose Customize. Click on the Options tab. Check off or remove the checkmark as appropriate:
Chapter 2 Creating a Presentation

In this chapter, you will learn:

- how to create a new presentation
- how to apply a presentation template
- how to make a title slide
- how to save a presentation

Creating a New Presentation

With a blank presentation, you have a few options in terms of slide formatting. You can create a master slide, which is basically a new template that will apply to your whole presentation. All your slides will have the same format, including text, title, bullets, and background. You can also format each individual slide to have different text styles or backgrounds. As well, you can apply a template to the presentation once you have added your text and graphics.

Creating a New Presentation:

1. **From the task pane, click Blank Presentation.** (If the task pane isn’t visible, click View→Task Pane)

2. **From the task pane, choose the appropriate Slide Layout.**

There are twelve different types of slides to insert. We will discuss the different types later in this manual. For now, insert a *Title Slide.*
Inserting a Title Slide:

1. **Select** the Title Slide icon at the top left-hand corner of the Slide Layout task pane by **clicking** on it once.

**Help!** Don’t see the task pane? Choose *Format→Slide Layout*

Applying a Template to a Presentation

If you want your presentation to have a consistent design from the very beginning, you can choose to use a *design template*. Design templates contain color schemes, formatted slides, and fonts designed for a specific look. After you apply a template to your presentation, each slide you add will have the same custom look, regardless of what kind it is.

PowerPoint comes with many professionally designed templates. You can also make your own templates. If you create a special look for one of your presentations, you can save it as a template. Using a template helps make creating slide presentations easy and painless. The template automatically formats and positions your text, and creates backgrounds and bullet styles. While the template will probably suit your needs, you can also edit parts of it, like the background or text colour, or remove the template from the presentation if it does not suit your needs. As well, you can apply a different template to your presentation, changing the look while keeping the content of the slide show unchanged.

Applying a Template to a Presentation:

1. **Click** *Format* on the menu bar, and **click** *Slide Design*.

2. **The task pane on the right will show many** templates.

3. **Move** down the list until you see the file *whirlpool.pot*. **Select** that file.

4. **Click on the picture** to apply it. **Click the down arrow beside the picture** and choose “**Apply to selected slides**” to apply the design to only the selected slide.
Creating a Title Slide

Filling Out a Title Slide:

1. Click once inside the text box that reads *Click to add title*.

2. Type *Your Perfect Vacation* into the box when the cursor appears.

3. Click once inside the box that reads *Click to add sub-title*.

4. When the cursor appears, type *Information to Make Planning Easier* into the box.

5. Click outside of the text box to finish.

You can format the text and reposition both the title and subtitle to fit your theme. We will cover these aspects of presentation design in the next chapter.

Saving Presentations

You should always save your presentation several times while you are creating it. That way, if your computer crashes or something else happens, you will not have lost that much work. You may also want to save your presentation as different files at several points during its creation. That way, if you dislike the direction it takes, you can go back to an earlier version and try again.

You may also want to include the fonts used in a presentation with the file. Since presentations are often created on one computer, and then used on another, to ensure the fonts look the same they should be embedded.

Saving a Presentation:

1. Click the *File* heading on the menu bar, then click *Save*. You can also click the *Save* icon on the toolbar.

2. Make sure that the folder you want to save your file in is selected. Check the *Save In: field to find out where your presentation will be saved on the computer.

3. Type a file name for your presentation, for example *vacation*, in the *File name: field*. 
4. On the Save As window, click on **Tools**→**Save Options**.

5. Choose **Embed True Type Fonts**, and click **OK**.

6. **Click Save**.

When you have saved your presentation once, all you have to do to save it again is press the *Save* button on the toolbar. You will not be asked to type in your filename again; PowerPoint will overwrite the existing file with the new one.

If you want to save your presentation as different files at different points during its creation, you need to follow this procedure:

### Saving a Presentation under a Different Name:

1. **Click** the *File* heading on the menu bar, then click *Save As*....

2. **Type** a different file name into the *File name:* field, for example *vacation2*.

3. **Click** *Save*. 
Chapter 3 Text

In this chapter, you will learn:

- how to insert a bulleted list slide
- how to insert text into a slide
- how to format bulleted lists
- how to format text in a slide

Inserting a Bulleted List Slide

In order to add text to your presentation, you must have a slide to type it into.

Inserting a Bulleted List Slide:

1. From the menu, choose **Insert**, and then choose **New Slide**.

2. The task pane should appear on the right side of the screen. Select the **Bulleted List slide**, from the **New Slide** task pane that appears.

A blank slide will appear on your screen. It should look like this:
Inserting Text

Text is the core of any slide presentation. Without it, the amount of information you communicate to your audience is limited. With that in mind, there are some important things to remember. First, slides should never be too cluttered. There is only so much information your audience can absorb from a slide that they are shown. A good guideline is include only 7 lines per slide. Second, your slides should not contain every word of your presentation. They should only be used to enhance what you are telling your audience, and to keep your presentation on track. Try to use only point form notes, rather than complete sentences. Third, because your slide show is a visual presentation, your text should be large enough to be seen easily, and should be written in a common, easy to read serif or sans serif font. These simple guidelines will help ensure that your presentation is successful.

Making a List Slide:

1. **Click** inside the text box that reads *Click to add title*.

2. **Type** *Easy Vacation Planning* when the cursor appears.

3. **Click** inside the text box that reads *Click to add text*.

4. **Type** the text you see below into the field when the cursor appears (press enter at the end of each line):

   - Pick a destination
   - Set your goals
   - Research

5. **Click** outside the text box to finish.

Bulleted Lists

PowerPoint automatically starts your bulleted list when you insert a list slide. There are, however, some points to discuss when it comes to lists.

Since PowerPoint presentations should only be used to supplement your complete presentation, lists are important features. You are able to present your main ideas in point form, and you allow your audience to identify the important topics you are discussing.

Just as with the rest of your presentation, consistency is important. Your bullets should be the same from slide to slide, and should not overpower your text. After all, people in your audience will pay more attention to a bullet that takes up half of the screen than the text it is marking! You can
also turn off the bullets if you feel they are not appropriate for the content of the slide.

Right now, let’s look using different levels of bullets. Here is an example of bullet text using levels:

- This is a first level bullet.
  - This is a second level bullet. It is a sub point of bullet number 1.
- This is back to the first level of bullets.

Making sub-bullets on a List Slide:

1. To add sub-bullets under the word Research as follows:

   - Pick a destination
   - Set your goals
   - Research
     - travel and accommodations
     - attractions
   - Make a time line

2. Position the cursor at the end of the word “Research”.
3. Press Enter.
4. Press Tab or click on the toolbar.
5. Type “Travel and accommodations”.
6. Press Enter.
7. Type “ Attractions”
8. Press Enter.
9. Press Shift+Tab or click on the toolbar.
10. Type “Make a time line”

<table>
<thead>
<tr>
<th>Command:</th>
<th>It means:</th>
</tr>
</thead>
<tbody>
<tr>
<td>or pressing Tab with the cursor before the text</td>
<td>“Demotes” text, making it a subtly smaller font size, and indenting it.</td>
</tr>
</tbody>
</table>
or pressing Shift+Tab with the cursor before the text

“Promotes” text, making it a subtly larger font size, and removing an indent.

**Turning Bullets Off and On:**

1. Select the list on your second slide, which is everything in the text box under your title.

2. Click the *Format* heading on the menu bar, then *click Bullet*…

3. Click the bullet style.

4. Click OK. Your list should no longer have bullets.

5. Select your list again if you have deselected it.

6. Click the *Format* heading on the menu bar, then *click Bullet*…

7. Click the picture of the bullet style you like. For example:

8. Click OK. Your list should have bullets again.

You can also change your bullet character, its colour, and its relative size.

**Changing Your Bullet Style:**

1. Select your list.

2. Click the *Format* heading on the menu bar, then *click Bullet*…

3. Click customize.

4. Select *Wingdings* from the font drop down box.
5. **Select** one of the symbols that appear below. You can see a larger preview of any symbol by clicking it once.

6. **Click OK**

7. **Click** the arrow at the end of the **Color:** field.

8. **Select** one of the colour squares.

9. **Decrease** the size of the bullet to 80% by clicking the down arrow next to the **Size:** field four times.

10. **Click OK**.

Your slide should look something like the one below, depending on the bullet character and colour you chose:

![Image of a PowerPoint slide with a list titled "Easy Vacation Planning" and bullet points including "Pick a destination," "Set your goals," "Research," "Travel and accommodations," "Attractions," and "Make a timeline."

Remember that text and lists are the core elements of your PowerPoint presentation. Without them, you communicate very little information to your audience. With this in mind, make sure that you have a consistent format, and that you are not trying to present too much information in one slide. The key to a successful presentation is simplicity.
Formatting Text

Once you have mastered inserting text, you can create informative and clear presentations easily. However, you might think that so far, your presentation is pretty boring to look at. To fix this problem, you will need to format your text.

You can change the size, colour, font, style, and effect of your text. For example, you might decide all your titles should be larger, blue, and in a different font from your other text, or you might decide your list items should be smaller and italicized.

Let’s begin with formatting the size of your text.

### Increasing Text Size:

1. **Move** to your title slide by **clicking** the scroll bar on the right side of your screen.

2. **Select** your title, *Your Perfect Vacation*, by **highlighting** it with your mouse.

3. **Click** the *Format* heading on the menu bar, then **click Font**. A menu will appear on your screen.

4. **Click** the *Size* field, which is the field on the far right. It should read *44*, which is the current font size.

5. **Select 72** from the menu below the *Size* field by **scrolling** down the list and **clicking** once on the number.

6. **Click OK**.

The size of your title should have increased (if it has not, ask your instructor for help). You will notice that it is now spread over two lines. To make the title fit on one line, you will have to **decrease** your font size slightly.

### Decreasing Text Size:

1. **Select** your title again if you have deselected it.

2. **Click** the *Format* heading on the menu bar, then **click Font**.
3. Click the Size field.

4. Select 60 from the menu below the Size field by scrolling down the list and clicking once on the number.

5. Click OK.

**Shortcut:** On the formatting toolbar, there are two buttons that look like this: ⬆️ and ⬇️. The first one increases your text size, and the second decreases it. Select the text you want to resize, then click one of these buttons.

You can also change the colour of your text.

### Changing Text Colour:

1. Select the subtitle: *Information to Make Planning Easier.*

2. Click the Format heading in the menu bar, then click **Font**. The Font menu will appear.

3. Click the arrow at the right side of the **Color** field, which is right under **Size**.

4. Click the blue square, which is third from the right.

5. Click **OK**.

6. Deselect your text to see the results.

If you want to use a different colour than the ones offered, click **More Colours**… at the bottom of the dropdown menu. You can then select colours from a **Standard** grid, or make your own **Custom** colours.

You can also change the font of your text.

### Changing Fonts:

1. Move to your second slide by clicking on the scroll bar on the right side of your screen.

2. Select your title: *Easy Vacation Planning.*
Producing Presentations

1. Select your slide title, Easy Vacation Planning.
2. Click the Format heading in the menu bar, then click Font. The Font menu will appear. The style field is second from the left.
3. Click Bold Italic.
4. Click OK.

Your title should now be slanted to the right and darker than it was before.

Applying an Effect:

1. Select your title, Easy Vacation Planning.
2. Click the Format heading in the menu bar, then click Font. You will see the available effects in the lower left of the Font menu.
3. Click the check box next to Emboss. It should now have a checkmark in it.
4. Click OK.
Chapter 4 Graphics

In this chapter, you will learn:

- how to insert a picture slide
- how to insert pictures
- how to use the picture toolbar
- how to insert an AutoShape
- how to use the drawing toolbar

Inserting a Picture Slide

While text is the basis for any presentation, graphics can make your slides more visually appealing, and can enhance the message you are trying to get across.

You can insert graphics from a variety of sources. PowerPoint comes with the Microsoft ClipArt Gallery, which contains over 1000 images in a variety of categories. As well, you can insert your own pictures. PowerPoint also provides you with a series of AutoShapes, such as arrows, banners, and stars.

Although you can insert a picture into any slide, PowerPoint provides you with two preformatted slides that are ready to accommodate pictures.

Inserting a Clip Art Slide:

1. Click **Insert** from the menu, and choose **New Slide**.

2. Select the **Text and Clip Art** slide from the task pane that appears.

3. Add the following text to your slide:
   
   In the Title box: **Destinations**
   In the Text box:
   - Europe
   - Mediterranean
   - Africa
   - Caribbean
   - United States
   - Canada

4. Click on **** to choose your clip art.
5. Click on the picture, and then click **OK**.

**Inserting Your Own Picture:**

1. **Click Insert** from the menu, and choose **New Slide**.

2. **Select** the **Text and Content** slide from the task pane that appears.

3. Click once on the Insert Picture icon on the slide.

4. Click the arrow at the end of the Look In: field to find the drive and folder your picture is in.

5. Select your image file.

6. Click OK.

7. Move your picture from the middle of your slide by dragging and dropping the image onto the clip art box.

**The Picture Toolbar**

If your picture is selected, you will see the Picture Toolbar. If you do not see the toolbar pictured below, **click** once on the picture. A box should appear around the picture, and the toolbar should appear somewhere on your screen.

If you still don’t see the toolbar, right click on the picture, and choose “**Show Picture Toolbar**”
You can use this toolbar to format the image you inserted. Below is a list of what the toolbar offers.

<table>
<thead>
<tr>
<th>Button:</th>
<th>What it does:</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Insert Picture from File]</td>
<td>Begins the procedure for inserting your own picture from a file.</td>
</tr>
<tr>
<td>![Image Control]</td>
<td>Allows you to change the way the picture looks. Your options are automatic</td>
</tr>
<tr>
<td></td>
<td>(in colour), grayscale (renders the picture in gray), black and white</td>
</tr>
<tr>
<td></td>
<td>(renders the picture in black and white), and watermark (washes the picture</td>
</tr>
<tr>
<td></td>
<td>out in white).</td>
</tr>
<tr>
<td>![Contrast + and –]</td>
<td>Allows you to increase and decrease the contrast between the colours of your</td>
</tr>
<tr>
<td>![Brightness + and –]</td>
<td>Allows you to increase and decrease the brightness of your picture.</td>
</tr>
<tr>
<td>![Crop]</td>
<td>Allows you to choose only part of the image to display. Place your cursor</td>
</tr>
<tr>
<td></td>
<td>over the squares in the corners and on the sides of the image, click and</td>
</tr>
<tr>
<td></td>
<td>hold, then move your mouse inwards. The command will move the edges of the</td>
</tr>
<tr>
<td></td>
<td>picture inwards.</td>
</tr>
</tbody>
</table>
Producing Presentations

without resizing the image.

**Line Style**
Allows you to frame your picture with a line.

**Recolor**
Allows you to change the colours in your picture.

**Format Picture**
Takes you to a menu that includes all the above commands.

**Set Transparent Color**
Allows you to set the colour that shows through the transparent sections of your image. If the button is grayed out, the image format cannot be set to transparent.

**Reset Picture**
Resets the image to its original specifications.

Inserting an AutoShape

When PowerPoint loads, the Drawing toolbar should appear at the bottom of your screen. It looks like this:

If you do not see this toolbar, click **View**, then click **Toolbars**, and **Drawing** to bring it up on your screen. You need it for the following exercise.

An AutoShape is a drawing object that Microsoft has provided. The menu includes many common shapes that you can use in your presentation. You can create and resize them to suit your needs.

There are eight different categories of AutoShapes. **Lines** include different styles of lines you can draw. **Connectors** are lines that you draw between two objects that will move with the objects they are connecting. **Basic Shapes** are the miscellaneous AutoShapes. **Block Arrows** are large arrows that can accommodate text if needed. **Flowchart** shapes can be used to create a flowchart. **Stars and Banners** give you several different types of stars and banners. **Callouts** give you cartoon-style speech balloons as well as more professional versions. Finally, **Action Buttons** provide Internet style buttons to indicate actions.
Inserting an AutoShape

1. **Insert** a 2 Column Text slide by **clicking** the **New Slide** button, selecting this icon, then **clicking** **OK**.

2. **Add** the following text to the slide:
   - In the Title box: **Set Your Goals**
   - In the left Text box:
     - Learn some history
     - Take lots of pictures
     - Make new friends
     - Get a tan
     - Experience a new culture
     - Have fun!

3. **Click** the **AutoShapes** button on the drawing toolbar.

4. **Select Basic Shapes**, then the happy face 😊.

5. **Click and hold** your right mouse button with your cursor somewhere on your slide, then **drag** your mouse down and to the right. The happy face should appear.

6. **Release** the mouse button.

Your happy face might not be the colour you want it to be. In the next section, you will use the Drawing toolbar to manipulate your image.

The Drawing Toolbar

You can use the drawing toolbar to manipulate all the drawing elements in your presentation. Below is a list of the commands available.

<table>
<thead>
<tr>
<th>Button</th>
<th>What it does:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="draw.png" alt="Draw" /></td>
<td>Takes you to a menu that includes commands like Rotate, Align, and Order.</td>
</tr>
<tr>
<td><img src="select_objects.png" alt="Select Objects" /></td>
<td>Allows you to select objects before you manipulate them.</td>
</tr>
<tr>
<td><img src="free_rotate.png" alt="Free Rotate" /></td>
<td>Lets you rotate your object with your mouse.</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td><strong>Producing Presentations</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>AutoShapes</td>
<td>Gives you the menu for inserting AutoShapes.</td>
</tr>
<tr>
<td>Line</td>
<td>Allows you to draw a line.</td>
</tr>
<tr>
<td>Arrow</td>
<td>Allows you to draw an arrow.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Allows you to draw a rectangle.</td>
</tr>
<tr>
<td>Oval</td>
<td>Allows you to draw an oval.</td>
</tr>
<tr>
<td>Text Box</td>
<td>Allows you to insert a text box that you can then type text into. This text is moveable.</td>
</tr>
<tr>
<td>Word Art</td>
<td>Allows you to insert Word Art (see Chapter 6 for more details).</td>
</tr>
<tr>
<td>Fill Color</td>
<td>Allows you to change the colour of your drawing object.</td>
</tr>
<tr>
<td>Line Color</td>
<td>Allows you to change the colour of the lines of your drawing object.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Allows you to change the colour of your text box or Word Art text.</td>
</tr>
<tr>
<td>Line Style</td>
<td>Allows you to change the thickness of your straight lines.</td>
</tr>
<tr>
<td>Dash Style</td>
<td>Allows you to change the style of your straight lines.</td>
</tr>
<tr>
<td>Arrow Style</td>
<td>Allows you to change the style of your arrows.</td>
</tr>
<tr>
<td>Shadow</td>
<td>Allows you to add a shadow to your drawing object.</td>
</tr>
<tr>
<td>3-D</td>
<td>Allows you to make your drawing object 3-dimensional.</td>
</tr>
</tbody>
</table>

The best way to learn to use the drawing toolbar is to take the time to experiment with it. For now, let’s try out a few of the features.

**Using the Drawing Toolbar:**

1. **Select** your happy face by **clicking** on it once.

2. **Click** the arrow next to the **Fill color** button.
3. **Click More Fill Colors**… at the bottom of the menu that appears.

4. **Select** a yellow from the Standard colours menu.

5. **Click OK**. Your happy face should now be yellow.

6. **Click** the **Shadow** button 🌫️.

7. **Select Shadow Style 16**, which looks like this 🌫️. Your happy face should now have a shadow that stretches off the right side of the screen.
Chapter 5 Tables

In this chapter, you will learn:

- how to insert a table slide
- how to create a table
- how to format tables

Inserting a Table Slide

Tables can be an effective way of presenting information to your audience. They are especially useful for presenting statistics and numbers. PowerPoint does not have its own built in table feature, but it does allow you to use Word’s powerful table tool.

PowerPoint provides you with a slide that is set up to import a table. The table slide is the easiest way to add a table to your presentation.

Inserting a Table Slide:

1. Click the Insert menu, and choose New Slide

2. From the task pane, under Other Layouts, choose Title and Table

3. Type Flight Costs into the title field.

Creating a Table

Once the table slide is inserted in your presentation, creating your table is simple.

Creating a Table:

1. Double-click in the box that reads Double click to add table.

2. Type 3 in the columns field, and 5 in the rows field when the dialog box appears.
3. **Click OK.** You should see something like this on your screen:

![Table Preview](image)

4. **Type** the following information into your table. You will be able to move from cell to cell by **pressing** the Tab key. When the cursor appears, **type** text into the cell, then **press Tab** to move to the next cell:

<table>
<thead>
<tr>
<th></th>
<th>January</th>
<th>June</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hawaii</td>
<td>$ 400</td>
<td>$ 550</td>
</tr>
<tr>
<td>London</td>
<td>$ 800</td>
<td>$ 1000</td>
</tr>
<tr>
<td>Rome</td>
<td>$ 900</td>
<td>$ 1050</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>$ 300</td>
<td>$ 500</td>
</tr>
</tbody>
</table>

5. **Click** outside of the table box.

**Formatting Tables**

Right now, your table does not look like much. In fact, there is no formatting of any kind.

PowerPoint allows you to use Microsoft Word’s table formats to make your table visually appealing. To do this, simply follow the procedure below.

The Word Tables and Borders toolbar should appear when your cursor is inside the table:
Producing Presentations

Tables

If you don’t see the toolbars, choose View → Toolbars → Tables and Borders

Inserting Rows

1. **Add** a row between **London** and **Hawaii**.
2. **Right Click** on the word **London**.
3. **Choose Insert Rows**
4. The row is inserted, but notice how the table does not fit on the slide.

<table>
<thead>
<tr>
<th></th>
<th>January</th>
<th>June</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hawaii</td>
<td>$400</td>
<td>$550</td>
</tr>
<tr>
<td>London</td>
<td>$800</td>
<td>$1100</td>
</tr>
<tr>
<td>Rome</td>
<td>$900</td>
<td>$1050</td>
</tr>
<tr>
<td>Las Vegas</td>
<td>$300</td>
<td>$500</td>
</tr>
</tbody>
</table>

5. Position your mouse pointer on the circular handle at the centre bottom of the table. You will see a double headed arrow:

6. **Click and drag the table until it fits well on the slide:**

<table>
<thead>
<tr>
<th></th>
<th>January</th>
<th>June</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hawaii</td>
<td>$400</td>
<td>$550</td>
</tr>
<tr>
<td>London</td>
<td>$800</td>
<td>$1100</td>
</tr>
<tr>
<td>Rome</td>
<td>$900</td>
<td>$1050</td>
</tr>
<tr>
<td>Las Vegas</td>
<td>$300</td>
<td>$500</td>
</tr>
</tbody>
</table>

7. **Add the text:** Toronto, $450, $550
Adding Fill Colours

1. **Select** the first row of the table.

2. **Click the down arrow** beside from the Tables and Borders toolbar.

3. **Choose** the **colour** from the menu:

   ![Colour options]

   - No Fill
   - Automatic
   - More Fill Colors...
   - Fill Effects...

4. For more colour choices and patterns use **More Fill Colors** or **Fill Effects**

Alignment within Cells

1. **Select** the table.

2. From the Tables and Borders toolbar, **click** to center text vertically.

3. From the Formatting toolbar, **click** to center text horizontally.

Adding/Removing Borders

1. **Select** the table.

2. From the Tables and Borders toolbar, **click** **Table**.

3. Choose Borders and Fill.
4. Click each border button until the screen appears as follows:

5. Click OK.
Chapter 6 WordArt

In this chapter, you will learn:

- how to insert WordArt
- how to format WordArt

Inserting WordArt

WordArt can add eye-catching titles and banners to your slides. It also lets you add special effects to text. WordArt can fit text into a variety of shapes, can apply 3-D effects, and can use any TrueType font on your computer.

You can insert WordArt into any slide. You can then resize and alter it to fit with the content of the slide and your presentation.

Inserting WordArt:

1. **Insert** a new slide, using the **Bullet List** content layout.

2. **Click** the WordArt button on the drawing toolbar at the bottom of your screen. It looks like this: ![WordArt button]

3. **Select** the fourth WordArt style in the last column. It should look like this: ![Fourth WordArt style]

4. **Click OK**.

5. **Type Attraction**s when the **Edit WordArt Text** dialog box appears.

6. **Click OK**. The WordArt should appear in the middle of your screen.

7. **Click and hold** the WordArt, then **drag** it to the right side of your slide.

8. Add the following bullet points:
Producing Presentations

- Museums
- Beaches
- History
- Culture

Formatting WordArt

You can easily format WordArt to suit your needs. The WordArt toolbar, which appears under the drawing toolbar when you select your WordArt object, gives you quick access to the tools you need. The toolbar looks like this:

Here is a list of what each button does:

<table>
<thead>
<tr>
<th>Button:</th>
<th>What It Does:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert WordArt" /></td>
<td>Begins process of inserting WordArt. The same button is on the drawing toolbar.</td>
</tr>
<tr>
<td><img src="image" alt="Edit Text..." /></td>
<td>Allows you to edit the WordArt text: the content, font and style.</td>
</tr>
<tr>
<td><img src="image" alt="WordArt Gallery" /></td>
<td>Shows you the types of WordArt available.</td>
</tr>
<tr>
<td><img src="image" alt="Format WordArt" /></td>
<td>Brings up a menu where you can alter the colour, size and position of the WordArt.</td>
</tr>
<tr>
<td><img src="image" alt="WordArt Shape" /></td>
<td>Allows you to change the shape of the WordArt.</td>
</tr>
<tr>
<td><img src="image" alt="Free Rotate" /></td>
<td>Allows you to rotate the WordArt using the mouse.</td>
</tr>
<tr>
<td><img src="image" alt="WordArt Same Letter Heights" /></td>
<td>Makes all your characters the same height and width.</td>
</tr>
<tr>
<td><img src="image" alt="WordArt Vertical Text" /></td>
<td>Changes your text from vertical to horizontal.</td>
</tr>
<tr>
<td><img src="image" alt="WordArt Alignment" /></td>
<td>Changes the alignment of your text, such as centered or justified.</td>
</tr>
</tbody>
</table>
Producing Presentations

WordArt

WordArt Character Spacing

Allows you to change the spacing between the characters in the WordArt.

We will go through some basic formatting for WordArt.

Formatting WordArt:

1. Select the WordArt object by clicking on it once.

2. Click the Format WordArt button on the WordArt toolbar. A menu will appear, and should show you the color tab.

3. Click the arrow next to the Fill: Color: field.

4. Click Fill Effects... at the bottom of the menu.

5. Change the WordArt colour by clicking the radio button next to Preset, then scrolling through the Preset colors: menu.

![Preset colors]

Choose Desert from the menu.

6. Click OK.

7. Click the Size tab on the Format WordArt menu.

8. Change the size of the WordArt by typing 180% in both the Height: and the Width: fields.

9. Click OK.

10. Move the WordArt to a new position by dragging and dropping it.

11. Click outside the WordArt.

Allow yourself some time to explore all the different WordArt formats and colours. They can add an impressive visual splash to your presentations.
Chapter 7 Animation

In this chapter, you will learn:

- how to find and use the animation toolbar
- how to animate your text and graphics
- how to customize your animation

The Animation Toolbar

A successful presentation depends on keeping the interest of your audience and communicating information clearly and concisely. Animating your presentation can assist you in doing that.

When you animate a slide, you can control when each element appears on the screen. By doing this, you can keep your presentation on track, and also make your audience more aware of when you move on to a new topic. When you have a list of items to present to your audience, you might want to build the list one item at a time. You can hide each item of your list until you need it by using animation.

You can animate both text and graphics. PowerPoint comes with many animation choices, which can be also accompanied by sound if you so desire.

Animation is simple to add to any presentation using the Animation Schemes task pane.

Animating Your Presentations

PowerPoint presentations are inherently visual, and animation can be a powerful enhancement to each slide.

Adding Animation to a Slide:

1. **Go back** to your title slide by using the scroll bar on the right side of your screen.

2. **Click** on your title: *Your Perfect Vacation*.

3. **Click** the *Slide Show* menu and choose *Animation Schemes*.
4. **Click** the *Fade in all* item on the task pane

<table>
<thead>
<tr>
<th>Subtle</th>
<th>Appear</th>
<th>Appear and dim</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fade in all</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. **Click** the *Apply to All Slides*.

You will not see any changes to your slide, but when you run your presentation, your text will be animated. An important point to remember about PowerPoint animation is that unless you specify otherwise, your presentation will *not* advance until you click the mouse or press the enter key. You can change this when you customize your animation.

### Customizing Animation

The animations available on the *Animation Effects* toolbar are only the most common ones. There are many variations and styles that you can use when you customize your animation.

You manipulate several aspects when you customize your animation. You can change your animation effect, as well as your sound. Also, you can change how you want your text to appear; as a sentence, one word at a time, or one letter at a time. You can make each line dim when the next one appears. You can also set your timings in the *Custom Animation* menu.

#### Customizing Animation:

1. **Move** to your second slide using the scroll bar on the right side of your screen.
2. **Click** once on your slide title: *Easy Vacation Planning*.
3. **Click** the *Slide Show* menu and choose *Custom Animation*.
4. **Click** the object on the slide you want to change the animation for.
5. **Select** the *Change* button from the Animation task pane. Choose a new Effect.
6. **Double Click** the text object name:
7. **Modify** any settings.

Your first two slides have now been animated. Take some time to explore the other animation options and find out which ones you like best.
Chapter 8 Formatting Slides

In this chapter, you will learn:

- how to change the background colour of your slides
- how to set slide footers
- how to apply templates to an existing presentation
- how to edit templates

Changing Slide Backgrounds

Changing the background colour of your slide can serve to draw more attention to what is being presented. A darker background can draw a person's attention to a bright graphic or light coloured text. In the same way, lighter backgrounds can enhance dark text and pictures. As well, dark backgrounds are good for presentations, and light backgrounds are better for printed slide shows, such as overheads or handouts.

You have many options when changing your background colours. You can use a solid colour, or you can use a fill effect such as a texture, or your own pictures. PowerPoint will place your background colour behind any text or images already on the slide.

### Changing Backgrounds:

1. **Scroll** down to your third slide, titled **Destinations**, using the scroll bar on the right side of your screen.

2. **Click** the **Format** heading in the menu bar, then **click Background**.

3. **Click** the arrow at the end of the **Background Fill** field below the preview box. It should look like this: ![dropdown](image)

4. **Click** **Fill Effects**.

5. **Click** the **Texture** tab.

6. **Select** the **White Marble** texture. It should be the second tile from the left in the middle row.

7. **Click** **OK**.

8. **Click** the **Apply** button. If you wanted this texture to be the background for all your slides, you would click **Apply to All**.
There are many textures, patterns, colours and pictures you could use as your background. Explore and decide which ones you like best.

**Slide Footers**

Slide footers are the best place to put common slide information like the date, slide number, or the occasion for the presentation. Any information you add to the footer will appear on every slide. If you insert the date or time of your presentation, PowerPoint can automatically update it for you.

**Editing the Slide Footer:**

1. **Click** the View heading on the menu bar, then **click Header and Footer**.

2. **Make sure** the Date and Time checkbox has a checkmark in it, ✔️, and **click** the Update automatically heading.

3. **Click** the arrow at the end of the date field, ✔️, and **select** a date format, for example June 9, 2004.

4. **Click** the checkbox next to Footer. There should be a checkmark in it.

5. **Type** Your Perfect Vacation into the field below it.

6. **Click** the checkbox next to Don’t show on title slide. There should now be a checkmark in it.

7. **Click** Apply to All.

The date and your presentation title will now appear on every slide except your title slide.

**Applying a Template**

Applying a template is an easy way to format your fonts, lists, and backgrounds. After you have created the content of your presentation, you can apply a template and apply all your formatting quickly.
### Producing Presentations

**Applying a Template to a Presentation:**

1. **Click** Format on the menu bar, and **click Slide Design**.

2. The task pane on the right will show many templates.

3. **Move** down the list until you see the file whirlpool.pot. **Select** that file.

4. **Click on the picture** to apply it. **Click the down arrow beside the picture** and choose “Apply to selected slides” to apply the design to only the selected slide.

### Formatting Slides

**Editing a Template Master**

If you want to change part of a template, you can do so by editing the master slide. Your changes will apply to your entire presentation. You can also create new templates by editing the master slide in a blank presentation and saving the presentation as a PowerPoint template.

**Editing a Template:**

1. **Click** the View heading on the menu bar, then **click Master >**, then **Slide Master**.

2. **Select Click to edit Master text styles**.

3. **Click** the Format heading on the menu bar, then **click Font**.

4. **Change** the colour of your text by **clicking** the arrow at the end of the **Color:** field, and **selecting** the light purple square. It should be the sixth box from the left.

5. **Click OK**.

6. **Click** the Format heading on the menu bar, then **click Bullet**.

7. **Select Wingdings** from the Bullets From: menu, then **select** a symbol that appears below.

8. **Click OK**.

9. **Click** the View heading on the menu bar, then **click Slide**.
By changing your master slide, you can apply changes to your entire presentation without having to format each slide individually. This procedure saves you time and prevents accidental inconsistencies.
Chapter 9 Other PowerPoint Features

In this chapter, you will learn:
- how to insert graphs
- how to insert organization charts
- how to change your slide transitions

Graphs
At times, it will be useful for you to present a graph to your audience. PowerPoint can create the graph for you and insert it into your presentation.

There are two steps to creating a graph: create a small spreadsheet with your information, and then pick a style.

Inserting a Graph:

1. **Click** the **Insert** menu and choose **New Slide**.

2. **Select** the **Title and Content** slide from the task pane.

3. **Type** "Timeline: Hours Spent" in the title box.

4. **Click** the **Chart** icon.

5. **Double-click** where it reads "Double click to add chart."

6. **Select** the data that appears by default with the data sheet and **delete** it by **pressing** the **Delete** key.
7. Type the following into the data sheet:

<table>
<thead>
<tr>
<th></th>
<th>London</th>
<th>Paris</th>
<th>Rome</th>
</tr>
</thead>
<tbody>
<tr>
<td>Museums</td>
<td>10</td>
<td>25</td>
<td>20</td>
</tr>
<tr>
<td>Attractions</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Shopping</td>
<td>10</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Relaxing</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

8. Close the data sheet by clicking the \(\times\) in the top right corner.

9. Click the Chart Type button \(\text{Chart}\) on the Chart toolbar at the top of your screen.

10. Select the 3-D Bar Chart \(\text{Chart}\) from the drop down menu.

11. Click outside the graph.

If you wish to edit your graph again, double-click it. It is important to know what type of graph suits the information you are trying to get across. Explore the chart toolbar and find out how it works.

Diagrams & Organization Charts

You might want to use an organization chart to display an organizational structure. PowerPoint's diagram and organization chart feature lets you design and insert these charts quickly and easily.

Inserting an Organization Chart:

12. Click the Insert menu and choose New Slide.

13. Select the Title and Content slide from the task pane.

1. 

2. Type the following in the title box: Places to Go.

3. Click the icon.
4. Choose the Organizational Chart diagram type:

![Organizational Chart diagram](image)

Organization Chart
Used to show hierarchical relationships

5. Type **Europe** in the top box.

6. Type **England, France, and Italy** in the three subordinate boxes.

7. Add a subordinate box to **England** by clicking the Subordinate box:

![Subordinate box](image)

8. Type **London** into the new subordinate box by clicking on it once, then typing the text.

9. Add subordinate boxes to **France** and **Italy**, typing **Paris** and **Rome** respectively.

**Slide Transitions**

You can change the way the next slide in your presentation appears by formatting your slide transitions.

**Changing Slide Transitions:**

1. **Scroll** back to your title slide using the scroll bar on the right side of your screen.

2. **Click** the **Slide Show** heading in the menu bar, then **click Slide Transition**. The Slide Transitions task pane will appear.
3. **Select** the *Checkerboard Across* effect from the task pane. You will see a preview of the effect above the field.

4. **Click** speed.

5. **Click Apply to All Slides.**

When you run your slide presentation, the transition will take you from one slide to another.
Chapter 10 PowerPoint Views

In this chapter, you will learn:

- what the different PowerPoint views are

PowerPoint Views

Views offer you different ways of looking at the same document. Each view shows you different aspects of your presentation, and makes it easier to do different tasks.

There are four different PowerPoint views. You can change your current view in two ways. The first is to click the View heading in the menu bar. The second is to use the view buttons located in the bottom left corner of your screen. The buttons look like this: 🎯 ⏯ ⏫ ⏸.

- **Normal View:** Up to this point, we have been working in Normal view. This is the default setting for PowerPoint. This view is useful in designing individual slides. There is only one slide on the screen at a time, which makes typing and formatting easier.

- **Slide Sorter View:** This view is also very useful for organizing your presentation. All your slides are displayed, smaller, on one screen. Here you can move slides to different places in your presentation by simply dragging and dropping them to their new position. It is also easy to add or delete slides.

Using the different PowerPoint views can make creating and manipulating your presentation easy. Take some time to become comfortable with them all.
Chapter 11 Presenting Slide Shows

In this chapter, you will learn:

- how to run your slide show
- how to set up a self running presentation

Running Your Slide Show

Once your presentation is completed, you should run through it before you present it to an audience. That way, you have a chance to get used to your transitions and animations, and you will know what to expect in advance.

Your slide show will start running from the slide that you are currently viewing, even if it is the last one. If you want to run the whole show, scroll up to the title slide of your presentation.

You can advance your slide show by either pressing the Enter key or clicking your left mouse button. The show will advance to the next slide, or the next animation, depending on the animation settings.

There are two ways to start your slide show. The first is to click Slide Show in the menu bar, and then clicking View Show. The second is to click the Slide Show button, which is located next to the view buttons on the bottom left corner of your screen.

Running a Slide Show:

1. **Change** your view back to Normal by pressing this button.

2. **Scroll** to the title slide of your presentation using the scroll bar on the right side of your screen.

3. **Click** the Slide Show button or choose the menu Slide Show then View Show.

4. **Press Enter** or click the left mouse button to advance the slide. If your presentation stops and does not appear to be doing anything, press Enter or click with your mouse. The presentation is waiting for your input.

5. **Press Enter** or click the left mouse button when you reach the last slide (it should be your organizational chart). You will return to the PowerPoint slide screen.
Self Running Slide Shows

While PowerPoint presentations are generally used to accompany speeches, you can also set your presentation to run automatically. There are several reasons you might do this. If the presentation is part of a booth at a conference or some other event, having it advance automatically is especially convenient. Also, if you will not be at a computer during your speech, and do not have an assistant to advance the slides for you, you can set the timing of your speech to advance at the appropriate interval.

Let's assume that you are setting up a slide show to run at a booth.

Setting Up a Self Running Show:

1. **Click** the *Slide Show* heading on the menu bar, then **click Set Up Show**.

2. **Click** *Browsed at a kiosk (full screen)*.

3. **Click** *Using timings, if present*, in the *Advance slides* box near the bottom.

4. **Click** *OK*.
5. **Click** the *Slide Show* heading on the menu bar, then **click Slide Transition**.

6. **Click** the check box next to *Automatically after*. There should be a checkmark in it.

7. **Replace** the 0 with 5 seconds.

8. **Click Apply to All**.

9. **Scroll** up to the title slide.

10. **Run** your slide show by **clicking** the *Slide Show* button 📀. Just sit back and watch; you do not have to do anything. To stop your slide show at any time, **press** the *Escape* key.
Chapter 12 Printing Presentations

In this chapter, you will learn:

- how to print PowerPoint presentations

Printing

Printing a presentation

1. Click File on the menu bar, then click Print…

2. From the “Print What” drop down, choose print layout that you would like. See examples below.

3. Choose print colour settings. For Black & White printers, “Pure black and white” is recommended. See below for samples.

4. Click OK.
<table>
<thead>
<tr>
<th>Print What type:</th>
<th>What it looks like:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Slides</strong></td>
<td>One slide per page, slide takes up full 8 ½ x 11 sheet.</td>
</tr>
<tr>
<td>![Slide Image]</td>
<td>![Slide Image]</td>
</tr>
<tr>
<td><strong>Handouts</strong></td>
<td>2, 3, 4 or 6 slides to a page</td>
</tr>
<tr>
<td>![Handout Image]</td>
<td>![Handout Image]</td>
</tr>
<tr>
<td><strong>Notes Pages</strong></td>
<td>Image of slide on the top of page, and “Speakers Notes” shown on the bottom. One slide per page.</td>
</tr>
<tr>
<td>![Notes Page Image]</td>
<td>![Notes Page Image]</td>
</tr>
</tbody>
</table>
### Print Colours : What it looks like:

**Colour**

The presentation will be printed in full colour. If not printing on a colour printer, this is not recommended as slides will be very dark.

**Grayscale**

All colours will be converted to shades of gray. If the background is dark, can be a dark print out on black & white printers.
Create a Word file for printing

Creating a Word file for printing

1. **Click File** on the menu bar, then **click Send To**....Then choose **Microsoft Word**.

2. From the dialog box choose the layout that you would like.

3. **Click OK**.
Chapter 13 Closing PowerPoint

In this chapter, you will learn:

■ how to close PowerPoint

Closing PowerPoint

Once you are finished for the day, you must close PowerPoint.

To Close PowerPoint:

1. Click the File heading on the menu bar, then click Exit.

2. Follow the directions to save your presentation if you have not done so already. If you have saved your presentation, PowerPoint will close and you will return to the Windows desktop.
Chapter 14 PowerPoint Books

Microsoft Books, are available online through the U of C library:
1. Go to www.ucalgary.ca/library
2. Click “Article Indexes”
3. Click “B”
4. Click “Books 24x7 IT Pro”
5. Click “Connect”
6. Type in PowerPoint in the search box, and choose “Titles”
   ![Search: PowerPoint - Titles](image)
7. Click “Go”